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Introduction 

In this introductory course, we explore the EndNote X9 package.  This course explores the 
main features of the software from the creation of an EndNote library through to the 
inserting citations into a Microsoft Word document.  EndNote is a powerful tool for anyone 
engaged in academic research, study and writing, during the course you will learn to use 
the most useful features contained in the application. 

Objectives 

On successful completion of this course, participants will be able to: 

 Create an EndNote Library 

 Add references manually 

 Import references from online databases  

 Import references using EndNote's Online Mode 

 Manage your references by and creating and using groups 

 Attach PDF documents to your references library 

 Check for and remove duplicates from in your EndNote library 

 Cite your references when writing in Word  

 Change citation styles within a Word document. 
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Introduction to EndNote Desktop 

1 What is EndNote? 

EndNote is a reference management application, which is used to manage bibliographies 
and references when writing theses, essays and articles. The software is available for both 
PC and Mac. 

EndNote allows you to: 

 Store all the references that you find during your research. They can be entered 
manually or downloaded from most databases.  

 Store PDF files, pictures, graphs, tables, etc.  

 Add citations to your work and create bibliographies in any output style (e.g. 
Harvard, Vancouver). There are 5,000 styles to choose from. 

2 The EndNote Library 

a. Introduction 

EndNote references are stored in a database called a library. EndNote 
libraries have the file extension .enl 

Each library has a corresponding folder with the extension .Data. This 
folder will have the same name as the library, and it is where images, 
PDF files, etc. are stored. If you move, copy, rename or delete a Library 
remember to do the same with its corresponding .Data folder.  

 You are not limited to the number of references you can store in a 
library.  However, it is recommended that you do not exceed 
100,000 references to maintain efficient performance of the database.  

 Although the software allows you to create as many libraries as you wish, it is 
strongly recommended that you keep all your references in just one library. This way 
you will know where to find them, and will not create duplicate records in other 
Libraries.  

 Within your library, you can create Groups (or subsets) to help you organise your 
references. Custom Groups are manually created by drag-and-dropping to copy 
references into a Group.  

 You can also create Smart Groups that use search criteria and dynamically update 
themselves. 

 Each EndNote record stores the information required to reference it in a 
Bibliography.  Other information, to help you with your research, such as keywords, 
notes, abstracts and URLs can be stored in a record as well.  

 You can attach PDF files and images to EndNote records, and you can annotate 
PDFs with highlights and your own comments. 
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b. Creating an EndNote Library 

Endnote libraries are the files that store your references, PDFs and other data.  You may 
store your library wherever you think it is most useful to you.  However when considering a 
suitable location for storing your library, think about where is easily accessible and easiest 
for creating back-ups.   

Although we can synchronise this local library with the online library of EndNote Basic, this 
is not a substitute to having a sensible and durable backup regime. 

 Task 1:  Create an Endnote Library 

 Choose File Menu, New… 

 

 Accept the default name My Endnote Library 

 Click Save 

 Once saved it will open automatically 

 If you need to click on the maximise button on the top left of the open library so that 
your open library fills the screen. 

Although your library should open automatically when you create it, you may in the future 
need to open a library.  This is done from the file menu by selecting: 

File > Open > Open Library 

 

c. Library Overview 

Once you have created a library  

 

 

 

 

 

Go to File, New to make a new 
Library, or Open to open an 

existing Library 
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The Endnote Library window is split into 3 panes:- Groups pane, Reference List pane 
and Tabs pane 

 

d. EndNote Modes 

EndNote has three display modes:  

 Local Library (Folder icon) 

 Online Search (Globe icon) 

 Integrated (Folder & Globe icon) 

These are displayed in the top left corner of EndNote 
above My Library 

Local Library displays all of the records held in your EndNote database. 

Online Search Mode is a temporary library that will display the results of online searches 
from within EndNote. Results from these searches are not added to your local library. 
These results can be reviewed and then selected references can be added to your library. 

Integrated Library and Online Search Mode will automatically import all of the results 
from an online search into your local library and mark them as ‘unfiled’. Use this mode 
with caution! 

1 The Reference List pane 

This shows a list of all your references, each displaying as a single 
line.  You can sort the references by clicking on a column heading 

2 The Groups pane 

These are subsets (or Folders) of 
references saved for easy retrieval.  
Click on the title of a group to see its 
contents displayed in the Reference 
List pane 

3 The Tabs pane 

This includes tabs to three commonly 
used functions – Reference, Preview 
and Attached PDF 
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e. Reference Overview 

 

 

 

To see all the details for a reference, you can either use 
the Reference tab, or double click on the Reference in 

the list 

Each Reference has its own unique number.  EndNote uses 
these numbers for formatting and they cannot be changed 

The font and size should both be set as 
Plain, unless you need a special style for a 

character.  You do NOT need to set italics or 
bold; EndNote will do this for you 

Use the Aa button if 

you need to change 
case – eg., for titles 
imported in all caps 

When you are typing in numbers, 
eg., for pages or volumes, you 
do not need to type v. or pp. 
before them – just the numbers 

Use the Options 

button to hide or 
display empty fields 
in the record and 
display the Ratings 
tool 

As well as the fields which are 
required to format your 
Bibliography, EndNote provides a 
number of fields for your own use, 
eg., to write your own research 
notes, attach files and images 
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EndNote X9 has 50 predefined reference types that it can store.  Records imported 
automatically from databases will usually have the correct reference type selected, but 
occasionally you will need to change it to achieve a better citation. 

EndNote has some features to help with your information management.  When you import 
records into EndNote they will be displayed in bold (unread). To help you keep track of 
your workload you can mark records when you have read them, and also assign a rating 
to remind yourself how useful you found the paper.  

3 Adding references using EndNote 

a. Manual Input 

Usually, References will be added to your Library by importing them directly from online 
databases, but occasionally you will need to make a manual record – for example, for a 
webpage, blog or unpublished report that does not have an electronic record for it.  

 

 

 

 

 Select the correct Reference Type 

 Remember that EndNote will do any standard formatting automatically so set Plain 
Font and Plain Size 

Click the New Reference button – a 
blank form will be displayed 
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 Type the information into the relevant fields.   
 
(Most of the fields you need to produce an adequate citation are towards the top of 
the page) 

 Click the Close button to save the reference 

The first time you attempt to close the reference-editing screen, you will be prompted 
with a message that asks you if you wish to save the reference.   

If you select the tick box before you answer yes, then this will be the last time that 
you see this dialogue box.  Manually created or edited references will be saved 
automatically whenever you close the dialogue box. 

Many of the fields are provided to help you organise your research, make useful 
notes, etc. You do not have to fill them all in. 

Sometimes, you will also need to edit records that you have imported from databases.  In 
this case double click a reference to edit. 

 Task 2:  Manually Create References 

With your existing library: 

 Manually create a new reference for a book e.g. 

Author:    Nixon, William 

Year:  2014 

Title:   EndNote 101 

Publisher:  University of Glasgow Press 

 Manually create a new reference for a journal article e.g. 

Author:   Harriman-Hunter, Judith 

Year:  2014 

Title:  Using EndNote for bibliographies 

Journal:  Journal of Bibliographies 

Volume:  1 

Issue:  1 

Pages:  100-110 

ISSN  1234-1234 

 Manually create a new reference for a book section e.g. 

Author:   Nixon, William 

Year:  2014 

Title:  Importing EndNote from Web of Science 

Editor:  Harriman-Hunter, Judith 
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Book Title: EndNote and Beyond 

Place:  Glasgow 

Publisher:  University of Glasgow Press 

 Create a number of other manual references; try different Reference Types to see 
the range of fields 

 Select the EndNote 101 reference that you created.   

 If you need to click on the Reference tab in the tabs pane (it will probably already be 
selected) 

 Click on the Place Published field in the tabs pane 

 Type in Glasgow 

 Select any other reference 

When you edit a reference in the tabs pane, the changes that you make are automatically 
saved at the point that you click on another reference. 

b. Importing References 

When you search databases to find journal articles, books and other material there will 
usually be options to export the results of your search so that you can import references 
into your own EndNote Library. In many cases, it is possible to import these results directly 
into EndNote.  Otherwise, you can usually export them to a file, and open that file (either 
automatically or manually) within Endnote. 

Many databases have an export, save or download option that will send your search 
results directly to EndNote. All you need to do is choose the EndNote Library into which 
the data should be imported. 

In a few databases, importing records is a two-step process where you save the results of 
your search into a file, then import that file into your EndNote Library using an Import 
Filter. 

Note that not all databases will have an option to export records to EndNote.  In those 
cases, you can try exporting the references in another format (i.e. Bibtex).  EndNote is 
able to read and import from many other reference library files.  It will, on occasions still be 
necessary to add details of those references manually to your library, as described in the 
previous section. 

c. Online Search Mode  

EndNote also provides an “Online Search Mode” which enables you to search for articles 
from EndNote itself. You may find this mode especially useful when you already know the 
book, journal article etc., that you wish to reference. 

EndNote is able to connect to a whole host of online catalogs and resources. 

Note however that the University does not have access to every one of the nearly 6,000 
resources that EndNote can connect too. 
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 Task 3:  Import references with Online Search Mode 

 Click on the Globe icon in the top left to enter Online Search mode.  

A number of resources are displayed including the Web of Science Core Collection 
and an option for more… 

In this example, we are going to search for examples of articles written by Padgett 
published in 2014.  

 Click on Web of Science Core Collection 

 

 In the search box, type the following: 

 

Author:  Padgett  

Year:  2014  

 Click on Search 

EndNote will do this search, report on the number of records found and ask for 
confirmation.  

 

Downloading the results of an online search can take some time.  If the number of 
records found is in very large, you will probably wish to cancel the search at this 
point and revise the search criteria you have used. 

 Click on OK and the results will be displayed in EndNote.  
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Note that these are not copied into your local Library in this mode. 

 Sort the results by Title by clicking on the Title column heading 

 Select “Optical angular momentum in a rotating frame” with a single click 

 Right click and use the Copy Reference to command to copy this to your library. 

 Holding the Control key and single click multiple other references 

 Click the Copy to Local Library button in the EndNote Toolbar 

 

Either of these methods will make a copy of a reference or references in your local 
library 

 Task 4:  Use the University of Glasgow Library Catalogue 

In our previous task, we used the Web of Science Connection file to search that catalog. 
Now we shall use a connection file for the University of Glasgow’s Library catalogue. 

With EndNote open and in Online Library Mode: 

 Click on more…  

The Choose a Connection dialogue box will open 

 Either: 

Scroll to U Glasgow.  
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Alternatively: 

Type Glasgow into the Quick Search box and click Enter 

 Select U Glasgow 

 Click Choose.  

It will now be displayed as U Glasgow in Online Search.  

 Select U Glasgow in the left hand pane 

 

The search terms from our previous task will still be present.  To remove them: 

 Click Options 

 Select Restore Default 

 

 Run a search for author, Hemingway, E (Confirm the search when prompted) 



 

Introduction to EndNote Desktop V1.2 11 

 Double-click on “Complete Poems” to see the full record,  

 Scroll down and you will see the Library call number and the status at the time of the 
search.  

 

 Close the reference 

 Copy it to your library. 

 Try a number of searches using Online Search Mode to add records to your Library 

4 Importing References from the Web 

It will often be preferable to import references from web based online catalogues rather 
than use EndNote's own online mode.  This may be because the data store you are using 
is not accessible via online mode, or possibly the web based interface offers you better 
search results and search tools 

Each web-based resource (such as Web of Science, SCOPUS, PubMed, etc.) will have its 
unique layout and features. It is not possible within this course to look at all of them, but 
almost all will have the ability to export references in a file that can be read by EndNote.  
We will look at two examples 

a. Importing from Web of Science 

The Web of Science database is owned by the same company as EndNote (Clarivate 
Analytics), and they work well together.  

References can be exported directly from Web of Knowledge to EndNote Basic (the web-
based version) or to EndNote Desktop. Records exported to EndNote Basic can by synced 
with EndNote Desktop. 

 Getting started with Web of Science (formerly Web of Knowledge) 

 Navigate to the Library Homepage (https://www.gla.ac.uk/myglasgow/library/) 

 From the Library home page, click on Databases by name from the Specific 
search group 
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 Use the search tool to find Web of Science 

 

 From the search results select Web of Science – Core Collection – Connect 

 

 Log in to the Web of Science database, you will need to provide your GUID and 
password to get connected 

 Type in your search terms e.g. Heisenberg principle and click on Search 

 

 From the list of results mark the records you want to export  

 

 Choose the Save to EndNote Desktop from the dropdown menu. 

 

 Choose record content, in this case Author, Title, Source and Abstract then click 
on Send 
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 Double Click on the .ciw file that downloads in your browser 

 The downloaded records should import directly into EndNote and will go into an 
Imported References group in EndNote Desktop.  

 

 If they do not, you will need to use File > Import > File and import the records from 
your Downloads folder, by default Web of Science records, for EndNote Desktop are 
exported as savedrecs.ciw.  

b. Importing from Article Search 

For our second example, we will import references from the Glasgow University Library 
website. 

 Task 5:  Import References from the Library Web Catalogue 

 Open Google Chrome 

 Navigate to https://www.gla.ac.uk/myglasgow/library/ 

 In the Search tool, type Heisenberg principle 

 

 Click Search 

Your results will appear in the browser 

 For any of the results in the browser, click the ellipses on the right hand side.  
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 From the drop down menu that appears select EndNote 

 Click on the file that downloads (it should appear in the bottom left hand corner of 
the browser) 

 

 Select the Chrome icon from your Windows Task Bar 

You will return to your web search results 

 In the results page click on the folder to the right of a different record  

The folder icon will change colour 

 

 Repeat this for more records 

 As you select records you will see the total number of records displayed in the folder 
in the top right. 

 

 Click on the folder to see the saved items.  

 Click the Export To… button 

 Choose EndNote as the export format. 
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 Click on the file that downloads 

 

 Follow the instructions to import the references 

If the records are not automatically imported into EndNote when you click on the 
downloaded files, they can be imported with the Reference Manager (RIS) option. 

 

5 Organising your References 

a. Using Groups 

Groups make it easy to break a large Library into subsets for later viewing. A group simply 
points to a subset of references that already exist in the Library.  

There are several types of groups that make it easy to organise your references in 
EndNote. Some of these groups are automatically generated and some are those you 
create yourself. You can further organise your references by storing multiple groups in 
custom Group Sets.  

Some things to note about using groups:  

 You can create a maximum of 500 Custom Groups and Smart Groups (combined) in 
a single Library.  

 A single reference will never appear more than once in a particular group. However, 
you can add that reference to any number of groups.  

 Removing a reference from a custom group does not delete it from the Library. It 
removes the reference from the group subset, but the reference still exists in the 
Library.  

 Deleting a reference from a Library also deletes it from all groups in that Library. The 
reference no longer exists.  

 Custom groups will transfer and be visible in both the Desktop and Basic (online) 
versions of EndNote 

 Group Sets, Smart Groups and other automatically generated groups will not appear 
when you are using the Basic (online) version of the product 

b. Creating a Custom Group 

You can create custom groups in order to organise your references. You might wish to 
make groups for each chapter of your thesis, or for different papers you are working on. 
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 Task 6:  Create a Set of Custom Groups 

 Click on the folder icon to enter Local Library Mode 

 

 Go to the Groups menu and choose Create Group Set 

 

 A box will appear in the Groups pane.   

 

 Type in the name you want to give the group set, e.g., Thesis  

 Hit Enter to save  

 Select the Thesis group set 

 Go to the Groups menu and choose Create Group  

 

 Name this group Chapter 1 

 Right click on the Thesis group set 
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 Select Create Group 

 Rename this group Chapter 2 

 Create a group named Chapter 3 using either method 

c. Adding References to groups 

An easy way to add some of your existing references to a custom group is simply to drag 
and drop the reference. 

 

When we do this, the number to the right of the group name will change from (0) to (1), 
this is displaying the number of references contained within the group. 

This is not the only way to achieve this; we can also right click on a reference (or a 
selection of references) and from the menu select the custom group that you wish to add 
the reference to. 
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The standard selection options work in the Reference List pane (click and CTRL click for 
individual references, click and SHIFT click for a consecutive list of references) 

If you choose Create Custom Group, your selection of references will be added to a new 
custom group.  After adding them, you can then rename this group to what ever suits you 

 Task 7:  Add References to Custom Groups 

 Click on All References 

 Select the Nixon, William – EndNote 101 reference with a single click 

 Drag the selected reference to the Chapter 1 group 

 Repeat this, but this time drag the same reference to the Chapter 2 group 

The same reference can appear in as many groups as you wish! 

 While holding your control key (Ctrl) click on several random references 

 Drag this selection to the Chapter 3 group 

 Right click on any of the references in the selection 

 From the menu that appears select Add References To – Create Custom Group 

 

 Under My Groups, Right Click New Group 

 

 Select Rename Group 

 Name the group Chapter 4 

 Drag the Chapter 4 group to below Chapter 3 
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d. Creating a Smart Group 

Smart groups are built with search strategies, for example, works by a particular author or 
matching some subject keywords. Smart groups are dynamically updated as you add 
references to and edit references in the library. 

Smart Groups will sync with your Basic (Online) account, but unfortunately will not 
display when you are using the web interface 

 Go to the Groups menu and choose Create Smart Group  

 

 Type in a descriptive name for the group  

 Type in keywords that will match some of your references 

 Select Any Field from the menu 
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 Click the Create button 

Any references you have in your EndNote 
Library which match the search criteria for your 
Smart Group will automatically be filed in the 
group, as will any future references you add. 

 Task 8: Creating Smart Groups 

 From the Menu select Groups – Create Smart Group 

 

 Fill the dialog box in as follows: 

 

Smart Group Name:  Nixon, William 

Author – Contains  Nixon, William 

 Click Create 

 If you need to move the Nixon, William smart group to the Thesis group set 

We can also create a smart group from an existing search: 

 Select All References 

 If there is no search panel available click Show Search Panel from the toolbar 

 

 Search for the Author Padgett 
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 Click Options – Convert to Smart Group 

 

 Right click the Converted Search smart group and rename it Padgett 

 Drag the Padgett group to the Thesis group set if necessary 

e. Managing Duplicates 

It is important to try to avoid duplicates of references 
in your EndNote Library. Duplicates can result in 
repeat references in bibliographies and these can be 
challenging to resolve.  Endnote has an inbuilt tool to 
help you manage duplicate references.   

The Find Duplicates tool is found inside the 
References menu.   

When you select the command, EndNote will perform 
a search of your library.  It looks for and identifies any 
references that it suspects are duplicates.  Rather 
than deleting suspected duplicates automatically, 
EndNote creates a dialog box that displays side by 
side the found duplicates. 

The user then can compare and select which record 
should be kept. 

 Task 9:  Managing Duplicates 

To check if your Library has any duplicates,  

 Click the References menu 

 Select Find Duplicates 

The Find Duplicates dialog box should appear. 
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 Compare the two references, you can use the sliders to scroll through all the fields 

 Click the corresponding Keep This Record button to select the record that should 
be kept 

6 Adding Full Text 

EndNote can store not just the details but also the full text PDFs of references that you 
have found. You can do this in a number of ways, depending on if you already have the 
reference in your EndNote library. 

a. Find Full Text 

EndNote can attempt to find and import full text (matching against the reference’s Digital 
Object Identifier) from the web.  To use this tool first select one or more references.  Then 

select References > Find Full Text, or use the Find Full Text icon  on the toolbar.  

EndNote will then perform a search.   

 If it finds a PDF copy of the reference's text, it will download and attach it to your 
reference 

 It may alternately not be able to download a PDF, but will find a URL that links to it 

 It may not find either the PDF or a link to it 

The progress and results of the search will be displayed in your Groups pane. 

Note that EndNote is unlikely to find the full text for all of your references. 

 Task 10: Use the Find Full Text tool 

 Select All References 

 Click on any of the references in your library 

 Use Ctrl-A to select all records in your library 

 Click the Find Full Text button from the toolbar 
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The search results appear as groups in your Groups pane 

 Click on the Found PDF group. (If the group exists) 

 

The results displayed will have paperclips beside the references 

 Select one of the records 

 In the Tabs group, select the Attached PDF tab 

 Observe the preview of the attached PDF 

 Click on the Found URL group 

 Double click on the Optical angular momentum in a rotating frame reference 

 Scroll down to the URL field 

 Click on the URL to see the page that contains the full text 

 Select EndNote from the Windows task bar 

b. Adding PDFs to an existing record 

In the last task, we attempted to find the full text for our references.  Some of those 
references were supplied as URL's rather than in PDF form.  When this happens, we can 
often download the full document and then attach it to our existing reference. 

PDFs can be manually added to a reference using References > File Attachments or 
with the paperclip icon in the record itself. 

 Task 11:  Attach a PDF to a reference 

In this task, we will attach a downloaded file to the Optical angular momentum in a 
rotating frame reference.  The file is already downloaded to your practice files folder 

 Click on the Found URL group 

 Select the Optical angular momentum in a rotating frame reference 

 Select References – File Attachments – Attach File 



 

Introduction to EndNote Desktop V1.2 24 

 

 Navigate to your practice folder (Your instructor will tell you where to find it if you are 
unsure) 

 

 Select the file named ol-39-10-2944.pdf 

 Click Open 

The PDF will become available in the Attached PDF tab.  Note that the reference 
does not save until you select another reference within EndNote 

 Select another reference 

c. Importing PDFs into EndNote 

If you have a PDF, you can import it directly into EndNote and EndNote will create a 
reference for it. The quality of the data in the reference will depend on whether the PDF 
has a Digital Object Identifier (DOI) on the first page and that EndNote correctly identifies 
it. 

 

If EndNote cannot identify the DOI, It may create a blank record and you will need to add 
the details manually. 
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You can import PDF's file-by-file into Endnote, or you can attempt to import an entire 
folder. 

 Task:  Import PDF's into Endnote 

 Click on the import button  in the toolbar.  

 

 Change Import Option to PDF. 

  

 It is also recommended that you set Duplicates to Import into Duplicates Library. 
This will avoid duplicates being added into your main library. 

 Click on the Choose… button 

The open dialog box will appear 

 Navigate to your practice files folder 

 Select the Arrizabalaga-2017-Fabrication of an Economical.pdf file 

 Click Open 

 Click Import 

 Double click the now imported reference and examine the fields 

 Close the newly imported reference 

 Task 13:  Import a folder 

Importing PDFs a file at a time is time consuming, especially if you have collected many 
PDFs.  In this task, we will import a folder. 

 Select File – Import – Folder 
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 Make sure the Import Option is set to PDF 

 

 Tick Include files in subfolders 

 Set the Duplicates to Import into Duplicates Library 

 Select Choose 

 Navigate to your practice folder 

 Select the folder named Import from folder 

 

 Click OK 

 Click Import  

 

After a short wait, the PDFs will import into new references. 

One of our imported PDFs does not have a readable DOI; unfortunately, its 
reference is not complete 
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 Double click the incomplete reference  

 

 Click on the Layout button on the bottom left corner of the Endnote Application 

 

 If it is not already ticked, select Right 

 Drag the split pane so that the PDF preview is large enough to read easily 

 

 Highlight the title Reducing Uncertainty: Implementation of Heisenberg Principle 
to Measure Company Performance on the PDF 

 Right hand click the title and choose copy 

 Paste the title into the Title field on the right hand side of the screen. 

You can fill in many of the fields with information gleaned from the PDF file if you 
need to. 

7 Creating a Bibliography: Using Cite while you write 

EndNote works with Word to easily and quickly cite references, and create a paper with 
properly formatted citations, a Bibliography, figures, and tables.  

This is all done using the EndNote X9 ribbon, which you will see in Word once you have 
installed EndNote Desktop on your PC. 

 

The EndNote X9 ribbon will look like this 

If you cannot find the EndNote X9 ribbon, please contact the IT Services Helpdesk via 
https://www.gla.ac.uk/myglasgow/it/helpdesk/ 
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a. Inserting Citations and Bibliographies into a document 

The first time we add an EndNote Reference to a document it typically will take a bit of 
time.  After that, references are added more or less instantly. 

There are several different methods for adding a reference to a document we namely: 

 Using the Insert Citation button from the EndNote X9 ribbon 

 Using the Insert Citation button in the EndNote application 

 Typing the reference details within {} curly brackets 

No matter what method you do, providing that Instant Formatting is On (A setting in the 
EndNote X9 ribbon), the reference will be added, formatted and an endnote 
generated/updated. 

We can also edit citations to include prefixes, suffixes and page numbers should the 
referencing style we are using support this. 

 Task 14:  Inserting Citations into a Word Document 

 From the EndNote practice files folder open Chapter 3.docx Word document 

 Position your cursor where you wish to place a citation in the text. Remember to 
leave a space between the last character and your cursor, and ensure that your 
citation is placed before the full stop at the end of a sentence 

 Click the Go to EndNote button from the EndNote X9 ribbon 

You will be taken to the EndNote application 

 Select the Chapter 3 group from the Thesis group set 

 

 Select the reference you want to use 

 Click the Insert Citation button  

 In a short while you will return to the Word document – the citation will now have 
appeared  

 If the citation is unformatted (i.e. in curly brackets) click the Instant Formatting is 
Off button and choose Turn Instant Formatting On 

 Select the style you want from the Style menu 

 

 Position your selection where you wish to place the next citation in the text.  

 Click the Insert Citation button in the EndNote X9 Ribbon 
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 In the Find & Insert My References dialog box, fill in the search box with the name 
Padgett 

 

 Click Find 

 Select two references from the list that appears (hold the Ctrl key to make a multiple 
selection 

 

 Click Insert 

 You should now have a correctly formatted citation and a bibliography at the end of 
your document (scroll to the end to see the bibliography) 
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b. Editing a Reference 

Once you have a reference into a document, you can edit it to include additional 
information such as page numbers, a prefix or suffix. 

Select the reference that you wish to edit and select Edit & Manage Citations 

 

Fill in the fields that you wish to edit and click OK.  If the Instant Formatting is on, you 
should see your edits appear.  If the edits do not appear, the style that you are using does 
not support the additional information. 

 Task 15:  Adding Page Numbers to a Reference 

 Change the Style to APA 6th in the EndNote X9 ribbon 

 Click on the first reference in your word document 

 Click Edit & Manage Citation(s) in the EndNote X9 Ribbon 

 In the Pages field type 113 

 Click OK 

The reference will update with the addition of p. 113 
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Appendix 1 
Endnote Basic (aka Online or Web) 

EndNote Basic is a FREE Web version of EndNote, which you may prefer to use off-
campus.  

Groups of records can be transferred easily between EndNote X9 Desktop and EndNote 
Basic, so you may choose to use the full software when you are in the University and the 
online version when you are at home. It is highly recommended that you use EndNote 
Basic to back up your EndNote references. You can also use EndNote Basic to share 
references and work collaboratively with others. 

EndNote Basic provides 2GB of storage for attachments.  However when you sync this 
with the Desktop version of EndNote you will be upgraded to a full account with unlimited 
storage space.   

The upgraded account stays for two years from the point at which they are synced, after 
which time the web version reverts to “Basic”, however no references are lost. The 
account is upgraded for a further two years when it is linked to the latest version of 
EndNote Desktop.  

a. Registration 

The first time you use EndNote Desktop you will be prompted to create an online account; 
this is probably the easiest method to create an account.  It will also set up sync for you at 
the same time 

Once you have registered, you can go to www.myendnoteweb.com and access the web 
based EndNote Basic 

Alternately, you can register for an account at the above web address. 

b. Using EndNote Basic 

Once you log in you will be EndNote Basic home page.  

 

http://www.myendnoteweb.com/
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Note that initially the header of this page is EndNote Basic – when you sync your Library 
with EndNote Desktop, the basic disappears from the header (bottom image) and it 
displays just EndNote. 

If you click on Hide Getting Started Guide (top right of the page), you will see your online 
EndNote Library 

 

c. Configuring EndNote Desktop to sync 

To configure EndNote Desktop to sync with EndNote online you first need to enable this 
feature. 

In EndNote Desktop go to Edit > Preferences and then select Sync from the left hand 
menu of options. 

 

Provide your Endnote online login and password, if you do not already have one when you 
click on Enable Sync you will be offered the chance to create an account. 



 

Introduction to EndNote Desktop V1.2 33 

 

Click on OK and EndNote Desktop will connect to EndNote online and import any records 
to the desktop version. If there are already records in the EndNote Desktop database, 
EndNote will warn you and will merge them. 

d. Installers and Web Capture Tool 

EndNote Basic has a number of free downloads available including a Capture Reference 
to capture web pages and Cite While You Write plug-ins for Windows and Apple Mac. 

These are available at Downloads 
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Appendix 2 
Advanced Preferences: Find Full Text 

To enable Find Full Text if you are using EndNote Desktop on a PC or laptop off-campus 
you need to provide the University’s EZproxy URL  

 Select Edit - Preferences - Find Full Text 

 In the URL field under Authenticate with: add 

 ezproxy.lib.gla.ac.uk/login 

 Then click on Apply 

 

 In EndNote, right click on a record and select Find Full Text > Authenticate.  

 Login with your GUID  

 

 Click Done  

Note: Depending on the record and availability of the PDF not all searches will return 
full text. 
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Appendix 3 
Generating a combined Bibliography, having 
merged all Chapters of a Thesis 

a. Method 1 

If you create your thesis work in individual chapters, you will then require to combine all 
chapters (placing section breaks between each - the Bibliography for each chapter will 
appear at the end of each section). 

 You should then cut the Bibliography at the end of the last chapter inserted (e.g. 
chapter 5) and paste it at the point in the combined file where you wish the full 
Bibliography to appear. 

 From that point, you then click Update Citations and Bibliography on the EndNote 
tab.  The full Bibliography will be generated at this point. 

 Check all references are correct and featured in this new full Bibliography, then 
delete those at the end of each chapter. 

b. Method 2 

 In each Chapter, from the EndNote X9 ribbon choose the drop down arrow on 
Convert Citations and Bibliography and click Convert to Unformatted Citations.   

All citations will be converted and the automatic bibliography at the end of each 
document will disappear.   

 Re-save each chapter. 

 Then, once you have combined all chapters together, sit at the point in the combined 
file where you wish the full Bibliography to appear.   

 Click Update Citations and Bibliography on the EndNote tab. 
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Useful Shortcut keys 

Function Shortcut 

Creates a new reference Ctrl + N 

To select more than one reference Ctrl + Click 

Selects a range of references Shift + Click 

Opens selected references Ctrl + E 

Closes the active window Ctrl + W 

Selects the next field Tab 

Selects the previous field Shift + Tab 

Open Library Ctrl+O 

Close Library Ctrl+W 

Save Ctrl+S 

Exit Ctrl+Q 

Undo Ctrl+Z 

Cut Ctrl+X 

Copy Ctrl+C 

Paste Ctrl+V 

Select All Ctrl+A 

New Reference Ctrl+N 

Edit References Ctrl+E 

Move References to Trash Ctrl+D 

Go To Ctrl+J 

URL > Open URL Ctrl+G 

Next Reference Ctrl+Page Down 

Previous Reference Ctrl+Page Up 

Show All References Ctrl+M 

Search Library Ctrl+F 

Help Contents F1 

 


